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GLOSARIO 
 

  CIM.  (Computer Integrated Manufacturing).  Sistema de Manufactura Integrada 
por Computador. 

 

 COM.  (Component Object Model).  Modelo de Componentes de Objeto.  
Herramienta de Software Desarrollada por Microsoft Windows. 

 

 CRM.  (Customer Relationship Management).  Administración de las Relaciones con 
el Cliente 

 

 DCS.  (Distributed Control System).  Sistema de Control Distribuido. 
 

 DDE.  (Dynamic Data Exchange).  Tecnología de Intercambio Dinámico de Datos. 
 

  ERP. (Enterprise Resource Planning).  Sistema de Planeación de Recursos de la 
Empresa. 

 

 GMAC.  Gestión de Mantenimiento asistida por Computador. 
 

 HMI.  (Human Machine Interface).  Interfase Humano Máquina. 
 

 ISA. (International Society of Automation). Sociedad Internacional de 
Automatización.  

 

 ISO. (International Organization for Standardization).  Organización Internacional 
de Estandarización. 

 

 LabVIEW. (Laboratory Virtual Instruments Engineering Workbench). Lenguaje y a la 

vez un entorno de programación gráfica en el que se pueden crear aplicaciones para 

instrumentación, automatización y control virtual 
 

 LAN.  (Local Area Network).  Red de Area Local. 
 

 MCS.  (Manufacturing Control System).  Sistema de Control de Manufactura. 
 

 MES.  (Manufacturing Execution System).  Sistema de Ejecución de Manufactura. 
 

 MMI.  (Man Machine Interface).  Interfase Hombre Máquina. 
 

 MODULO I/O.  Módulo con Canales de Entrada y Canales de Salida para monitoreo 
y manipulación de instrumentación de proceso. 

 

 NIST. (National Institute of Standards and Technology).  Instituto Nacional de 
Estándares y Tecnología  



 

 

 

 OLE.  (Object Linking and Embeeding).  Vinculación e Inserción de Objetos.  
Herramienta de Microsoft que permite a las aplicaciones leer y escribir valores de 
proceso y que los datos sean compartidos fácilmente en una red de PC’s. 

 

 OPC.  (OLE for Process Control).  Es un estándar abierto para compartir datos entre 
dispositivos de campo y aplicaciones de PC, basado en OLE de Microsoft. 

 

 OPTO22.  Compañía de fabricación que se especializa en los productos del 
hardware y de software para automatización industrial. 

 

 PC.  (Personal Computer).  Computador Personal. 
 

 PAC.  (Programmable Automation Controller).  Controlador Programable de 
Automatización, versión SNAP desarrollado por OPTO22. 

 

 PLC.  (Programmable Logic Controller).  Controlador Lógico Programable. 
 

 PLM.  (Product Lifecycle Management).  Administración del Ciclo de Vida del 
Producto 

 

 P&ID.  Diagrama de Proceso e Instrumentación.  Estandarizado bajo la Norma ISA / 
ANSI S5.1 / 84. 

 

 RTU.  (Remote Terminal Unit).  Unidad Terminal Remota. 
 

 SCADA.  (Supervisory Control And Data Acquisition).  Sistema de Supervisión de 
Control y Adquisición de Datos. 

 

 SCM.  (Supply Chain Management). Administración de la Cadena de Suministros. 
 

 TCP/IP. (Transmission Control Protocol/Internet Protocol). Protocolo de Control de 
Transmisión/Protocolo de Internet  
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OBJETIVOS 
 

 

OBJETIVO GENERAL 

 

• Implementar LabView como sistema SCADA para la arquitectura de control Opto 

22, mediante una aplicación OPC.  

 

OBJETIVOS ESPECÍFICOS 

 

• Desarrollar  una práctica de laboratorio que permita utilizar la aplicación OPC como 

protocolo de comunicación entre 2 sistemas de control de diferente 

fabricante(LabView-Opto 22).  

• Implementar LabView como sistema SCADA para la arquitectura de control Opto 

22, mediante una aplicación OPC. 

• Realizar una interfaz gráfica para monitorear y controlar el módulo SNAP-PAC 

desde LabView. 
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INTRODUCCIÓN 
 

Uno de los elementos fundamentales que poseen las empresas del mundo moderno es la 

información.  Esta debe ser concreta, concisa y oportuna, sin importar el dispositivo de 

procedencia; por ésta razón el proceso de integración juega un papel fundamental para 

garantizar el correcto manejo de dicha información, de lo que depende hoy en día el 

rendimiento, la productividad, la competitividad y la permanencia de las empresas e industrias 

en el mundo moderno. 

 

En las últimas décadas, los avances en el área de la automatización han centrado sus esfuerzos 

en optimizar los procesos de producción y la seguridad en las organizaciones, por medio de la 

integración de  los niveles de Instrumentación y control, con los sistemas tecnológicos de 

gestión empresarial, a través de los sistemas SCADA. Éste enfoque permite una gran variedad 

de aplicaciones, entre las que se destaca el modelo de Manufactura Integrada por Computador 

(CIM - Computer Integrated Manufacturing), el cual enlaza los procesos de producción (diseño, 

ingeniería y fabricación), con los de gestión de la empresa (planeación y administración). 

 

Los procesos de modernización en los sistemas productivos, normalmente involucran la 

necesidad de la adquisición de aplicaciones SCADA (Supervisory Control And Data Adquisition) 

que regularmente "amarran" a una empresa con un solo fabricante, pues lo que normalmente 

se ofrece es una "solución llave en mano" o en paquete en la que el mismo fabricante del 

hardware industrial ofrece el software para comunicarse con los equipos y para llevar a cabo la 

integración, el monitoreo y el control.  Una solución así suele ser muy costosa, y dificulta la 

integración de tecnologías de diferentes proveedores, o de equipos nuevos y viejos.  Como una 

respuesta a este problema se propone la utilización del estándar OPC (OLE/COM for Process 

Control ) una tecnología de protocolos de alto nivel para el desarrollo de aplicaciones de 

software interoperable en sistemas distribuidos, para el monitoreo y control en plantas 

industriales, esto daría cabida a que equipos de diferentes fabricantes puedan trabajar sin que 

se presenten conflictos entre ellos y facilitando el que cada empresa cree aplicaciones de 

medición y control hechas a su medida, sin tener que depender de una sola casa fabricante de 

equipos y sin tener que pagar los altos costos que implica el licenciamiento de software 

industrial. 

 

 

El propósito de ésta monografía es la realización de un pequeño estado del arte de la 

integración tecnológica entre los diferentes dispositivos y medios utilizados en la ciencia de la 

automatización como base fundamental del modelo de manufactura integrada por 

computador,  realizando como aplicación  práctica la implementación del Sistema SCADA de 

LabVIEW integrado con el sistema de control SNAP PAC de OPTO22, por medio del protocolo 

industrial OPC. 
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1. FUNDAMENTO TEÓRICO DEL PROYECTO 
 

1.1. MODELO CIM 

 

Para ubicarse un poco en los protocolos de comunicación existentes, es conveniente 

basarse en modelos preestablecidos y estandarizados, como el modelo CIM, el cual 

permite ubicar fácilmente el nivel de comunicación que se está empleando. 

 

 
Figura 1. Modelo Teórico CIM según NIST.  [6] 

Este concepto responde a una estructura piramidal jerarquizada, produciéndose en la 

cúspide las decisiones de política empresarial.  En el otro extremo, en la base, lo que se 

pretende es que las denominadas islas de automatización, mediante los autómatas 

programables, controladores locales, instrumentación inteligente, etc., se integren en 

un sistema de control jerarquizado y distribuido que permita la conversión de 

decisiones de política empresarial en operaciones de control de bajo nivel. [2] 

 

El modelo de integración tecnológica propuesto por el CIM involucra el enlace del 

sistema SCADA con los niveles de Instrumentación y control. 
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1.1.1. Nivel de Proceso e Instrumentación. 

Comprende el conjunto de subprocesos, instrumentos y maquinaria en general, con 

que se realizan las operaciones de producción en la empresa.  En este nivel se 

adquieren las variables del proceso mediante sensores situados en él, y se actúa sobre 

él mediante elementos finales de control.  Los sensores envían la información de las 

variables al nivel sistema de control, para que ejecute los algoritmos de control y 

teniendo en cuenta los resultados obtenidos, envíe las órdenes oportunas a los 

actuadores.  Por lo tanto, este nivel es el encargado de la comunicación de los 

diferentes controladores del nivel sistema de control con los dispositivos de campo. 

[1][2] 

 

 

Figura 2.  Nivel de Proceso e Instrumentación.  [1][3] 

Dentro de los aspectos más importantes a tener en cuenta en este nivel se tienen: 

 Definición y características del proceso. 

 Caracterización de variables de proceso (Tipo de variable, Sistema de unidades, 

rangos). 

 Definición de lazos de control del proceso. 

 Señalización estandarizada de instrumentos según la ISA, ya sea convencional 

(4 a 20mA), protocolo (RS-232), ó bus de campo (Fieldbus Foundation). 

 Definición de instrumentación digital y analógica, de acuerdo a la variable y tipo 

de control. 

 Selección del principio de medición de instrumentos acorde a las características 

de la variable y necesidades del proceso. 
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 Implementación de instrumentación mecánica de respaldo a los instrumentos 

electrónicos de variables críticas, en caso de fallo de energía.  

 Identificación funcional de instrumentos y lazos de control, según norma ISA 

S5.1, en planta y en los diagramas P&ID. 

 

1.1.2. Nivel Sistema de Control. 

En este nivel se encuentran los Controladores Lógicos Programables (PLC`s), Unidades 

Terminales Remotas (RTU´s), Controladores Industriales, Sistemas de Control 

Distribuido (DCS) y demás dispositivos electrónicos de control.  En suma, constituyen 

los elementos de mando y control de la maquinaria del nivel de proceso e 

instrumentación.   

El presente nivel recibe y proporciona la información de actuación directa al nivel de 

proceso e instrumentación, y recibe y proporciona la información de estado al nivel 

sistema SCADA. [1][2]   

 

 

Figura 3.  Nivel Sistema de Control.  [1][8] 

Entre las funciones específicas de mayor relevancia de este nivel se tienen: 

 Capturar y digitalizar las señales estándares provenientes del nivel de proceso e 

instrumentación.  

 Ejecutar las cartas de programación, basadas en las estrategias de control del 

proceso. 

 Convertir en señales estándares de instrumentación, la información digital 

producto de la ejecución de las cartas de programación.  

 Mantener comunicación permanente con el nivel sistema SCADA, desde donde 

puede ser monitoreado y programada cada una de sus acciones. 

 Garantizar la seguridad y el control del Proceso. 
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Dentro de las características de este nivel se pueden describir las siguientes: 

 Dentro de su estructura básica cuenta con una CPU, módulos I/O con 

señalización estándar ISA para la comunicación con el nivel de proceso e 

instrumentación, y módulos de comunicaciones para la transferencia de 

información entre este nivel y el nivel sistema SCADA. 

 Su arquitectura modular y abierta permite soportar la expansión de las 

variables de proceso de la planta y establecer comunicación con otros 

controladores de este mismo nivel. 

 El sistema de acondicionamiento de señales debe garantizar el aislamiento 

eléctrico total entre las señales de control y potencia. 

 

1.1.3. Nivel Sistema SCADA.   

Es el nivel de supervisión y control.  En este nivel, bien por medios humanos o 

informáticos, se realizan las siguientes tareas: Adquisición y tratamiento de datos, 

supervisión del control del proceso, control de obra en curso y gestión de alarmas y 

asistencias, entre otras.  Dependiendo de la filosofía de control de la empresa, este 

nivel emite órdenes de ejecución al nivel sistema de control y recibe situaciones de 

estado de dicho nivel.  Igualmente recibe los programas de producción, calidad, 

mantenimiento, etc., del nivel sistema MES y realimenta dicho nivel con las incidencias 

(estado de órdenes de trabajo, situación de máquinas, estado de la obra en curso, etc.) 

ocurridas en planta. [1][2] 

Se da el nombre de SCADA (Supervisory Control And Data Adquisition ó Control con 

Supervisión y Adquisición de Datos) a cualquier software que permita el acceso a datos 

remotos de un proceso y permita, utilizando las herramientas de comunicación 

necesarias en cada caso, el control del mismo. [4] 

  

Figura 4.  Nivel Sistema SCADA.  [1][2] 

 

No se trata de un sistema de control, sino de una utilidad software de monitorización ó 

supervisión, que realiza la tarea de interfase entre el nivel sistema de control y el nivel 

sistema MES. 

http://images.google.com.co/imgres?imgurl=http://www.paginasprodigy.com/controlaplicad/ph_img/SCADA.jpg&imgrefurl=http://www.paginasprodigy.com/controlaplicad/cursoscada.html&usg=__t498ViJASr-QlGCvZKbnXVksQO4=&h=592&w=803&sz=117&hl=es&start=5&um=1&itbs=1&tbnid=n-4xrTXNb431AM:&tbnh=105&tbnw=143&prev=/images?q=scada&um=1&hl=es&tbs=isch:1
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Los objetivos para que su implementación sea perfectamente aprovechada son los 

siguientes: 

 Funcionalidad completa de manejo y visualización en sistema operativo 

Windows sobre cualquier PC estándar. 

 Arquitectura abierta que permita combinaciones con aplicaciones estándar y de 

usuario, que permitan a los integradores crear soluciones de mando y 

supervisión optimizadas (Active X para ampliación de prestaciones, OPC para 

comunicaciones con terceros, OLE-DB para comunicación con bases de datos, 

lenguaje estándar integrado como Visual Basic o C. 

 Sencillez de instalación, sin exigencias de hardware elevadas, fáciles de utilizar 

y con interfaces amigables con el usuario. 

 Permitir la integración con las herramientas ofimáticas y de producción. 

 Fácilmente configurable y escalable, debe ser capaz de crecer o adaptarse 

según las cambiantes necesidades de la empresa. 

 Ser independiente del sector y la tecnología. 

 Funciones de mando y supervisión integradas. 

 Comunicaciones flexibles para poder comunicarse con total facilidad y de forma 

transparente al usuario con el equipo de planta y con el resto de la empresa 

(redes locales y de gestión). 

 

La topología de un SCADA (su distribución física) variará adecuándose a las 

características de cada aplicación.  Unos sistemas funcionarán bien en configuraciones 

de bus, otros en configuraciones de anillo.  Unos necesitarán equipos redundantes 

debido a las características del proceso, etc. [4] 

Todos los sistemas, de mayor o menor complejidad, orientados a los objetivos 

mencionados anteriormente, aparecen bajo uno de los nombres más habituales para 

definir esta relación: 

MMI – Man Machine Interface – Interfase Hombre Máquina. 

HMI – Human Machine Interface – Interfase Humano Máquina. 

 

Un sistema SCADA, como herramienta de interfase humano máquina, comprende toda 

una serie de funciones y utilidades encaminadas a establecer una comunicación lo más 

clara posible entre el proceso y el operador. 
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1.2. PROTOCOLOS DE COMUNICACIÓN  

En principio un protocolo de comunicación es un conjunto de reglas que permiten la 

transferencia e intercambio de datos entre los distintos dispositivos que conforman 

una red. Estos han tenido un proceso de evolución gradual a medida que la tecnología 

electrónica ha avanzado y muy en especial en lo que se refiere a los 

microprocesadores. 

 
Figura 5. Evolución de la Instrumentación  (Tipos de Señales y Redes) [5] 

 

 

Figura 6. Resumen de Tipos de Redes y Aplicaciones en la Pirámide de Automatización [5]  



 

8 

 

 

Figura 7 Clasificación de las Redes [5]  

 

Los protocolos de comunicación aplicados en la industria  se pueden clasificar en: 

 

 SEÑALES DE INSTRUMENTOS (Nivel de Instrumentación y Control):  

o TRADICIONALES: 4-20mA, Pulsos, mV y Resistencia. 

o ULTIMA TECNOLOGIA: HART, Profibus, Fieldbus e Inalámbricos 

 PROTOCOLOS DE EQUIPOS(Nivel Control y SCADA): 

o MODBUS, TCP/IP, OPC 

 REDES DE CONTROL Y DATOS(Nivel MES y ERP): 

o  CSMA/CD: IEEE 802.3 

o TOKEN RING: IEEE 802.5 

o WIRELESS: IEEE802.11 

 

En los protocolos de Equipos es donde se encuentra el protocolo OPC el cual es la base 

del desarrollo de éste proyecto. A continuación se exponen los protocolos de Equipos 

o mejor conocido como Tecnologías de comunicación entre aplicaciones. 
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1.3. TECNOLOGÍAS DE COMUNICACIÓN ENTRE APLICACIONES 

 

1.3.1. Protocolo TCP/IP 

TCP/IP son las siglas de Protocolo de Control de Transmisión/Protocolo de Internet (en 

inglés Transmission Control Protocol/Internet Protocol), un sistema de protocolos que 

hacen posibles servicios Telnet, FTP, E-mail, y otros entre ordenadores que no 

pertenecen a la misma red. 

 

El Protocolo de Control de Transmisión (TCP) permite a dos anfitriones establecer una 

conexión e intercambiar datos. El TCP garantiza la entrega de datos, es decir, que los 

datos no se pierdan durante la transmisión y también garantiza que los paquetes sean 

entregados en el mismo orden en el cual fueron enviados. 

 

El Protocolo de Internet (IP) utiliza direcciones que son series de cuatro números 

octetos (byte) con un formato de punto decimal, por ejemplo: 69.5.163.59 

Los Protocolos de Aplicación como HTTP y FTP se basan y utilizan TCP/IP. 

 

1.3.2. Protocolo MODBUS TCP/IP 

MODBUS TCP/IP es una variante o extensión del protocolo Modbus que permite 

utilizarlo sobre la capa de transporte TCP/IP. De este modo, Modbus-TCP se puede 

utilizar en Internet, de hecho, este fue uno de los objetivos que motivó su desarrollo 

(la especificación del protocolo se ha remitido a la IETF=Internet Engineering Task 

Force). En la práctica, un dispositivo instalado en Europa podría ser direccionado desde 

EEUU o cualquier otra parte del mundo. 

MODBUS® TCP/IP se ha convertido en un estándar industrial de facto debido a su 

simplicidad, bajo coste, necesidades mínimas en cuanto a componentes de hardware, 

y sobre todo a que se trata de un protocolo abierto. En la actualidad hay cientos de 

dispositivos MODBUS® TCP/IP disponibles en el mercado. Se emplea para intercambiar 

información entre dispositivos, así como monitorizarlos y gestionarlos. También se 

emplea para la gestión de entradas/salidas distribuidas, siendo el protocolo más 

popular entre los fabricantes de este tipo de componentes. 

La combinación de una red física versátil y escalable como Ethernet con el estándar 

universal de inter-redes TCP/IP y una representación de datos independiente de 

fabricante, como MODBUS®, proporciona una red abierta y accesible para el 

intercambio de datos de proceso. 

El protocolo Modbus TCPModbus/TCP simplemente encapsula una trama Modbus en 

un segmento TCP. TCP proporciona un servicio orientado a conexión fiable, lo que 

significa que toda consulta espera una respuesta. Esta técnica de consulta/respuesta 

http://www.masadelante.com/faq-protocolo-de-aplicacion.htm
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encaja perfectamente con la naturaleza Maestro/Esclavo de Modbus, añadido a la 

ventaja del determinismo que las redes Ethernet conmutadas ofrecen a los usuarios en 

la industria. El empleo del protocolo abierto Modbus con TCP proporciona una 

solución para la gestión desde unos pocos a decenas de miles de nodos. 

 

Figura 8. Construcción de un paquete de datos Modbus TCP [5] 

 

Las prestaciones dependen básicamente de la red y el hardware. Si se usa MODBUS® 

TCP/IP sobre Internet, las prestaciones serán las correspondientes a tiempos de 

respuesta en Internet, que no siempre serán las deseables para un sistema de control. 

Sin embargo pueden ser suficientes para la comunicación destinada a depuración y 

mantenimiento, evitando así desplazamientos al lugar de la instalación. Si disponemos 

de una Intranet de altas prestaciones con conmutadores Ethernet de alta velocidad, la 

situación es totalmente diferente. 

1.3.3. Protocolo OPC SERVER. 

El estándar de intercambio de datos por excelencia se denomina OPC (OLE for Process 

Control).  Es un estándar abierto de comunicaciones que permite un método fiable 

para acceder a los datos desde los dispositivos de campo.  El método de acceso 

siempre es el mismo, sin depender del tipo y origen de los datos. 

 

Se basa en la tecnología COM (Component Object Model), de Microsoft, que permite 

definir cualquier elemento de campo mediante sus propiedades, convirtiéndolo en una 

interface.  De esta manera es posible conectar fácilmente cualquier elemento de 

campo con un servidor de datos local (COM), o remoto (DCOM). 
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1.4. PROTOCOLO OPC 

 

Figura 9. OPC Foundation [14] 

1.4.1 El porqué del OPC. 

Los procesos de modernización en los sistemas productivos, normalmente involucran 

la necesidad de la adquisición de aplicaciones SCADA (Supervisory Control And Data 

Adquisition) que  regularmente "amarran" a una empresa con un solo fabricante, pues 

lo que normalmente se ofrece es una "solución llave en mano" o en paquete en la que 

el mismo fabricante del hardware industrial ofrece el software para comunicarse con 

los equipos y para llevar a cabo la integración, el monitoreo y el control. 

 

Una solución así suele ser muy costosa, y dificulta la integración de tecnologías de 

diferentes proveedores, o de equipos nuevos y viejos. Otro problema común de los 

sistemas SCADA es que no cumplen con todos los requerimientos que una empresa 

necesita, o por el contrario están sobredimensionados para lo que el usuario final 

requiere realmente, haciendo que este pague una gran suma de dinero por una 

cantidad de funcionalidades que nunca usará, incluso se pueden presentar problemas, 

cuando se piensa en que el sistema debe ser usado por usuarios no expertos, para los 

cuales el manejo de una herramienta grande y compleja puede ser muy difícil. 

 

Una solución a estos problemas sería el desarrollo de sistemas de monitoreo y control 

propios, pero cuando se desarrollan aplicaciones distribuidas en ambientes industriales 

usando tecnologías tradicionales de programación, se encuentran problemas difíciles 

de sortear, debido a que cada fabricante ha creado de manera independiente sus 

propias aplicaciones para que los sistemas informáticos se comuniquen con sus 

equipos industriales y a que en general, el software y el hardware desarrollados por un 

fabricante no son fáciles de integrar con los de otro, pues no están obligados a hacer 

desarrollos compatibles con los desarrollos de la competencia.  

Es común que también que un fabricante receloso de su propiedad intelectual, 

simplemente no revele los detalles de funcionamiento de sus equipos, dificultando con 

esto aun más el diseño de soluciones de automatización de plantas donde hay equipos 

de diferentes proveedores. 
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Figura 10. Antes de OPC [5] 

Antes de OPC, cada dispositivo tenía que ser consultado por separado por cada 

aplicación, lo que significaba un gran trabajo en la implementación y una comunicación 

poco eficiente. 

 

1.4.2 Solución OPC 

Como una respuesta a estos problemas se propone la utilización del estándar OPC 

(OLE/COM for Process Control ) una tecnología de protocolos de alto nivel para el 

desarrollo de aplicaciones de software interoperable en sistemas distribuidos, para el 

monitoreo y control en plantas industriales, esto daría cabida a que equipos de 

diferentes fabricantes puedan trabajar sin que se presenten conflictos entre ellos y 

facilitando el que cada empresa cree aplicaciones de medición y control hechas a su 

medida, sin tener que depender de una sola casa fabricante de equipos y sin tener que 

pagar los altos costos que implica el licenciamiento de software industrial. 

 

 
Figura 11. Antes de OPC [5] 
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1.4.3 Funcionamiento 

Son las tecnologías OLE/COM (Object Linking and Embedding / Component Object 

Model) de Microsoft las que constituyen la base de la tecnología OPC, que es una 

arquitectura de Cliente- Servidor que brinda una muy buena plataforma para extraer 

datos de una fuente (en este caso un equipo Industrial) y a través de un servidor 

comunicarlos a cualquier aplicación cliente de manera estándar [OPC-Fundation 

(1998)]. Los fabricantes de hardware pueden desarrollar servidores optimizados para 

recoger datos de sus dispositivos [OPC-Fundation (1998)], dando al servidor una 

interfaz OPC que permite a cualquier cliente acceder a dichos dispositivos. 

Para que un sistema como este pueda funcionar apropiadamente, el equipo industrial 

debe soportar la comunicación con un servidor OPC, este servidor, no es más que un 

programa ejecutándose localmente en el mismo computador donde corre la aplicación 

de monitoreo y control o remotamente en otro equipo que actúe servidor 

(computador o no), este se encarga funcionar como una pasarela de información 

(gateway) entre las aplicaciones de software de monitoreo y control y el equipo 

industrial haciendo que la comunicación sea totalmente transparente [OPCFundation 

(1998)]. 

El estándar OPC consta de varias especificaciones que permiten la obtención y envío 

de datos en Tiempo Real (DA), Datos Históricos (HDA), Alarmas y Eventos (A&E), y 

varios otros menos utilizados. 

 

1.4.4 Partes del Estándar OPC 

 

La arquitectura de una red que trabaja con el standard OPC siempre consta al menos 

de 3 partes.  

a) Un dispositivo o aplicación (hardware o software) de cualquier marca o fabricante, 

el cual genera o contiene los datos que queremos obtener.  Podemos estar hablando 

de un PLC, un DCS, una báscula, una Base de Datos, un fichero de Excel, un RTU, un 

Switch, un Router o cualquier otro hardware o software que contenga datos. 

b) Un Servidor OPC específico para este Hardware o Software.  Un Servidor OPC es un 

software que "conoce" el lenguaje propietario del Hardware o Software de dónde 

sacará los datos. 

Hay Servidores OPC para las diferentes marcas de dispositivos (Siemens, Allen Bradley, 

Omron, GE, Schneider, Honeywell, Emerson, Yokogawa, ABB, etc.) además de 

Servidores OPC para Excel (DDE) para Bases de Datos (ODBC), para hardware 

informático (SNMP), para protocolos conocidos como Modbus o IEC o DNP3, entre 

muchos otros. 
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Normalmente cada fabricante vende su propio Servidor OPC pero existen empresas 

dedicadas a la conectividad industrial como MatrikonOPC que también venden 

Servidores OPC para todo este hardware o software.[12] 

c) Un Cliente OPC.  Un Cliente OPC es un software que tiene implementadas las 

especificaciones estándar y que puede comunicarse con cualquier Servidor OPC. Al ser 

OPC un protocolo abierto, cualquier Cliente OPC puede conectarse con cualquier 

Servidor OPC sin importar desarrolladores ni fabricantes. 

Hay Clientes OPC para obtener datos en Tiempo Real (Cliente OPC DA) para obtener 

datos Históricos (Cliente OPC HDA), etc. 

Un Cliente OPC puede ser una aplicación en Visual Basic, un SCADA ya que todos 

incorporan esta funcionalidad, una aplicación tipo LabVIEW, etc. 

Cualquier programador puede hacerse su propio Cliente OPC ya que las 

especificaciones se pueden descargar de www.opcfoundation.org.[7] 

 

1.4.5 Tipos de Servidores OPC 

Hay 4 tipos de Servidores OPC definidos por la Fundación OPC: 

 OPC DA Server - Basado en la especificación OPC Data Access – 

           Especialmente     diseñado para transmisión de datos en Tiempo Real. 

 

 OPC HDA Server – Basado en la especificación OPC Historical Data 

Access  Provee a los Clientes OPC HDA con datos históricos. 

 

 OPC A&E Server - Basado en la especificación OPC Alarms & Events     

           Especialmente - Transfiere información de Alarmas y Eventos a Clientes        

           OPC     A&E. 

 

 OPC UA Server – Basado en la especificación de Arquitectura Unificada     

           (UA) -     Basado en OPC UA es la especificación más reciente, Permite          

           al OPC Server trabajar con cualquier tipo de dato. 

http://www.opcfoundation.org/
http://www.matrikonopc.es/opc-servidor/opc-data-access-versions.aspx
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Figura 12. Partes estándar de OPC [12] 

 
 

1.4.6 Comunicaciones OPC Cliente - OPC Servidor - (OPC DA Server, OPC HDA 

Server, OPC A&E Server) 

Los Servidores OPC utilizan la infraestructura COM/DCOM de Microsoft Windows 

como plataforma de intercambio de datos. Esto significa que un OPC Server debe 

ejecutarse en un Sistema Operativo Microsoft Windows. Un Servidor OPC puede 

soportar comunicaciones con múltiples Clientes OPC simultáneamente. 

1.4.6.1 OPC Server - Traducción de Datos/Mapeo. La función principal de un 

Servidor OPC es la de traducir los datos provenientes de la Fuente de Datos 

en un protocolo propietario en el formato OPC para que sea compatible con 

una o varias Especificaciones OPC. (Ejemplo: OPC DA para datos de Tiempo 

Real). Las Especificaciones de la Fundación OPC solamente definen la 

comunicación OPC entre Servidor y Cliente OPC. La eficiencia y calidad de 

las comunicaciones entre el OPC Server y los dispositivos dependen 

únicamente del trabajo del desarrollador del OPC Server. 

 

http://www.matrikonopc.es/opc-servidor/opc-client-server.aspx
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1.4.6.2 Comunicaciones Servidor OPC - Fuente de Datos. Los Servidores OPC se 

comunican con el protocolo nativo con las Fuentes de Datos como pueden 

ser: Dispositivos, controladores, aplicaciones, etc. La Fundación OPC no 

específica la forma como un Servidor OPC debe comunicarse con una 

Fuente de Datos debido principalmente a la enorme variedad. Cada 

Dispositivo, controlador o aplicación diferente utiliza un protocolo o API 

diferente que incluso puede comunicar sobre distintos medios físicos (Serie 

RS485 o RS232, Ethernet, Wireless, etc.). Dos ejemplos comunes sobre la 

conectividad entre Servidores OPC y dispositivos son: 

 A través de una Application Programming Interfase (API). Una aplicación para 

conectar de forma propietaria con una fuente da datos particulares. 

 

 A través de un protocolo que puede o no ser propietario. (Ejemplo de protocolo 

propietario: ver MatrikonOPC Server for Honeywell TPS) (Ejemplo de protocolo 

abierto: ver MatrikonOPC Server for Modbus). 
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1.5 LABVIEW 

En éste proyecto se utiliza LabVIEW  como el sistema SCADA el cual se ubica en el 

tercer nivel del modelo CIM y desarrolla como funciones principales el monitoreo, 

control y visualización de HMI para el usuario final. 

1.5.1 Qué es LabVIEW 

LabVIEW: Laboratory Virtual Instruments Engineering Workbench.  

 

 

 

 

 
Figura 13.Ingreso a LabVIEW 8.6 [17] 

 

LabVIEW, de National Instruments es un lenguaje y a la vez un entorno de 

programación gráfica en el que se pueden crear aplicaciones para instrumentación, 

automatización y control virtual, además es un entorno de desarrollo flexible que está 

diseñado para ayudar a que los ingenieros integren fácilmente muchos componentes 

distintos dentro de un sistema completo de monitoreo y control. 

 

National Instruments (NI) es la empresa desarrolladora y propietaria de LabVIEW (1976 

en Austin, Texas).  NI comenzó el desarrollo de LabVIEW en 1983, lanzando su versión 

1.0 en 1986. 

Originalmente LabVIEW como herramienta de programación gráfica estaba orientada a 

aplicaciones de control de instrumentos electrónicos usadas en el desarrollo de 

sistemas de instrumentación. Por tal motivo los programas creados en LabVIEW 

reciben el nombre de Instrumentos Virtuales VIs (Virtual Instruments) con extensión 

.VI.  [8] 
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El siguiente vínculo muestra como puede usar LabVIEW en diferentes aplicaciones sean 

de la academia o industrial.  http://www.ni.com/labview/whatis/esa/applications.htm 

 

1.5.2 LabVIEW como un Servidor OPC 

Con LabVIEW 8 y en versiones más actuales, usted puede publicar cualquier tipo de 

datos que tenga en un servidor nativo OPC utilizando una variable compartida. Usando 

este método, usted puede publicar cualquier dato que tenga en LabVIEW en cualquier 

aplicación que pueda actuar como Cliente OPC. 

 

1.5.3 Agregando la Funcionalidad de Cliente OPC a LabVIEW  

El Módulo de LabVIEW DSC extiende el ambiente de desarrollo gráfico LabVIEW con 

funcionalidad adicional para un rápido desarrollo de aplicaciones de medición 

distribuida, control y monitoreo de alta cuenta de canales. El Módulo DSC proporciona 

herramientas al ambiente LabVIEW, haciéndole fácil graficar los históricos de las 

tendencias en tiempo real, mejorar la seguridad en pantallas principales, tener acceso 

a datos automáticamente, así como agregar un sistema de alarma, escala y seguridad a 

la variable compartida. Adicionalmente, una de las mayores características que el 

modulo LabVIEW DSC proporciona, es la habilidad para LabVIEW de funcionar como un 

cliente OPC abierto, proporcionando una conectividad fácil con cualquier servidor 

implementando los fundamentos OPC a partir de la interface del servidor OPC. El 

Módulo DSC encuentra instalados a todos los servidores OPC y lee cualquier 

información disponible acerca de las capacidades del servidor y selecciona 

directamente del servidor. [9]. 

 

1.5.4 Formas de conectar LabVIEW A UN PLC 

Con el software de LabVIEW es posible programar cualquier controlador lógico 

programable (PLC) en una variedad de formas. OPC (OLE for Process Control) define el 

estándar para comunicar datos en tiempo real de la planta entre los dispositivos de 

control y las interfaces hombre-máquina (HMI). Los servidores OPC están disponibles 

virtualmente para todos los PLCs y para PACs (Programmable Automation Controller). 

Existe un tutorial donde aprenderá cómo usar LabVIEW para comunicarse con un PLC 

conectado utilizando un OPC. El módulo DSC (Datalogging and Supervisory Control) es 

utilizado en ése tutorial. A continuación se describen de forma resumida los pasos a 

seguir. Para más información diríjase al tutorial de NI. [10] 

http://www.ni.com/labview/whatis/esa/applications.htm
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El primer paso es verificar los nombres de los PLC existentes en NI OPC Server. 

1. Ingrese a NI OPC Servers seleccionando Start » Programs » National Instruments 

» NI OPC Servers » NI OPC Servers. Con NI OPC Servers usted puede crear, 

configurar y ver etiquetas que se asocian con su PLC. 

2. NI OPC Servers debe abrirse con la simulación de un proyecto que ya ha sido 

creado y configurado en NI OPC Servers. 

 

Figura 14. PLC simulado en NI OPC Servers 

3. Observe las etiquetas Sine expandiendo Channel_0_User_Defined y 

seleccionando Sine. Las etiquetas aparecen en la parte derecha de la ventana. Estas 

etiquetas, que están limitadas a los registros de los PLCs, son leídas en LabVIEW. 

4.   Verifique los datos de las etiquetas de los PLCs OPC           

a. En NI OPC Servers, seleccione Tools » Launch OPC Quick Client para ingresar 

al OPC Quick Client, el cual se usa para ver los datos de las etiquetas del OPC. 

b. Expanda el archivo National Instruments.NIOPCServers y seleccione 

Channel_0_User_Defined.Sine para seleccionar el dispositivo a monitorear. 

c. Note que todas las etiquetas Sine están ubicadas en la derecha y se actualizan 

con datos simulados, tal como se muestra en la Figura 14: 



 

20 

 

 

Figura 15. NI OPC Quick Client desplegando etiquetas Sine OPC simuladas 

Nota: para una lista de dispositivos y drivers soportador por NI OPC, visite ni.com/opc. 

1.5.4.1 Conecte LabVIEW al PLC utilizando un servidor I/O: En esta sección. 

Se creará una interfaz en LabVIEW para las etiquetas (tags) OPC llamadas 

I/O Server. El I/O Server automáticamente actualiza LabVIEW con los 

valores de las etiquetas actuales en el rango que usted especifica. 

1. La ventana de Getting Started. haga clic en File » New Project para abrir un 

Nuevo proyecto en LabVIEW. 

2. En la ventana LabVIEW Proyect, haga clic derecho en My Computer y seleccione 

New » I/O Server, como se muestra en la figura 16: 

 

Figura 16. Creando un Nuevo Servidor I/O en LabVIEW Project.  
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3. Seleccione OPC Client en la ventana Create New I/O Server y haga clic en  

Continue.   

4. Seleccione National Instruments.NIOPCServers en el campo  Registered OPC 

servers y ajuste Update rate (ms) a100. Esto crea una conexión de LabVIEW hacia 

las etiquetas del OPC, las cuales se actualizan cada 100 ms.  

 

 

Figura 17. Configurando OPC Client I/O Server 

5. Seleccione OK. Una biblioteca se creará automáticamente en la ventana 

proyect explorer para manejar el I/O Server.    

6. Guarde el proyecto como OPCDemoProject y la biblioteca como 

OPCDemoLibrary seleccionando File » Save All de la ventana Proyect Exporer.  

 

1.5.4.2 Crear variables compartidas que conectan las etiquetas OPC al I/O Server: 

En esta sección, se crean las variables compartidas, las cuales están 

limitadas en las etiquetas del OPC, dándole el acceso nativo en LabVIEW a 

los datos del PLC. Con la variable compartida, usted puede compartir datos 

a través de los usos de LabVIEW en una sola computadora o a través de la 

red. 

1. Cree nuevas variables compartidas para el uso del OPC del PLC  

a) En la ventana LabVIEW Proyect, clic derecho en My Computer y 

seleccione New » Library, para crear una nueva biblioteca de variables 

compartidas, que son utilizadas para conectarlas a las etiquetas del OPC 

del PLC.  
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b) Clic derecho en la nueva biblioteca y seleccione Create Bound 

Variables…  

c) En la ventana Create Bound Variables seleccione las etiquetas del OPC 

para atarlas a las variables compartidas buscando los datos Sine en el 

árbol del OPC server como se muestra en la Figura 18.  

 

Figura 18. Seleccionando las etiquetas del OPC para las variables compartidas. 

d) Seleccione todos los objetos Sine y haga clic en Add y OK para crear las 
variables compartidas que están limitadas a las etiquetas del OPC del 
PLC  y cargarlas dentro de Multiple Variable Editor.  

e) En Multiple Variable Editor, seleccione Done para añadir las variables 
compartidas que fueron creadas anteriormente.  

2. Guarde la nueva biblioteca como OPCItems.lvlib en la ventana del proyecto 
haciendo clic derecho en la biblioteca y seleccionando Save As.  

3. Despliegue las variables compartidas haciendo clic derecho en la biblioteca 
OPCItems y seleccionando  Deploy para publicar las variables compartidas, 
hacerlas disponibles para otras redes, clientes OPC, y en LabVIEW Real-Time 
PAC.  

Ahora puede acceder a los datos nativos del  PLC  en  LabVIEW por medio de las 
variables compartidas. 

 

1.5.4.3 Ver variables compartidas con Distributed System Manager 

1. Desde Proyect Explorer, seleccione Tools » Distributed System Manager para 
abrir una ventana donde puede manejar sus variables compartidas en 
diferentes formas.  

http://www.ni.com/pac
http://www.ni.com/pac
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2. En el árbol  Variable Manager, expanda localhost bajo la categoría de My 

Systems. Clic derecho en la biblioteca OPCItems, y seleccione watch list para 

desplegar las variables compartidas, donde se encuentran las etiquetas OPC del 

PLC.  

3. Las variables compartidas se estarán actualizando con el dato seno simulado.  

 

1.5.4.4 Usando los datos del OPC en LabVIEW 

1. Desde Proyecto Explorer, haga clic derecho en  My Computer y seleccione New 

» VI. Para crear una interfaz de usuario y un código grafico ejecutable.  

2. Seleccione View » Controls Palette seguido de Express » Graph Indicators » 

Chart  y ubíquela en el panel frontal como se muestra en la figura 19.  

 

Figura 19. Seleccione una Waveform Chart  de la paleta Controls. 

 

Figura 20. Waveform Chart ubicada en el Panel frontal 
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1. En la ventana del VI seleccione Window » Show Block Diagram o presione 

<Ctrl+E> para mostrar el diagrama de bloques. 

2. En la ventana del proyecto, expanda la biblioteca OPCitems y seleccione la 

variable compartida Sine1. 

3. Arrastre y suelte la variable compartida Sine1 desde la ventana del proyecto 

hasta el diagrama de bloques 

4. Cablee la variable compartida Sine1 con la grafica waveform chart. 

5.  Introduzca un While Loop al diagrama de bloques  abriendo View » Functions 

Palette y seleccionando Express » Execution Control » While Loop. 

6. Usando el cursor del While Loop, posicione el While Loop alrededor  de la 

variable compartida y la gráfica. 

 

Figura 21. While Loop alrededor de la Variable Compartida y de Waveform Chart 

 

9. Convierta el while loop en un timed loop haciendo clic derecho en while loop 

y seleccionando Replace with Timed Loop. 

10. Para configurar el Timed Loop, doble clic en el nodo de entrada. Aparecerá la 

ventanaConfigure Timed Loop, ajuste el periodo Period a 100 ms seguido de ok. 
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Figura 22. Ajuste el Período a 100 ms. 

11. Regrese al panel frontal seleccionando Window » Show Front Panel o 
presionando <Ctrl+E>. 

12. Clic en el botón Run para ejecutar el VI. 

13. Clic Close en la ventana Deploy… una vez que éste termine. Cuando la 
aplicación empieza a ejecutarse, usted observará la forma de onda seno Sine1 
desplegada en la gráfica. 

 

Figura 23. Panel Frontal Completo – Desplegando un dato del PLC en una Waveform Chart 
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1.6   OPTO 22. 

1.6.1 Que es OPTO 22 

Es una empresa fabricante de productos de hardware y software para la 
automatización industrial, monitoreo remoto y adquisición de datos.  Su nombre se ha 
creado debido a la fabricación de relés de estado sólido, y a los sistemas de entrada y 
salida como los controladores basados en la tecnología del sistema Ethernet.   

Al hablar del software OPTO 22, tenemos que ver sus diferentes componentes para la 
realización del proceso de un sistema SCADA.   

Este software esta enlazado con la nueva tecnología del PAC (Programmable 
Automation Controller, Controlador Programable de Automatización.) 

 

Figura 24. Paquetes del PAC PROJECT 8.2 

Este software está compuesto por la versión PAC PROJECT 8.2, que lleva incluido los 
paquetes como: 

OPTO OPC SERVER: Es el software encargado de realizar las comunicaciones con 
diferentes tecnologías.   

PAC CONTROL PRO: Encargado de realizar la estrategia de control y la configuración de 
las señales. 

PAC DISPLAY CONFIGURATOR PRO: En este programa se diseña el HMI (Human 
Machin Interface), con el cual se manejara el proceso programado en el PAC CONTROL 
PRO. 

PAC DISPLAY RUNTIME PRO: Es el software encargado de correr el HMI que ya se 
había diseñado en el PAC DISPLAY CONFIGURATOR PRO, aquí se vera en su totalidad el 
diseño del proceso en funcionamiento, monitoreando, adquiriendo datos y haciendo 
control. 
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PAC MANAGER: Este software se encarga de configurar las comunicaciones ya sean 
por Ethernet protocolo TCP/IP y también las comunicaciones por puerto serial. 

1.6.2 Que es OPTO OPC SERVER. 

El OPTO OPC SERVER actúa como un traductor de OPC, utilizando como equipos de 
adquisición de datos todos los controladores de la serie R y S, llevando las señales que 
toman de campo y las que está ejecutando el software y así compartir dicha cantidad 
de mensajes en un servidor general el cual se encarga de enlazar toda esta información 
a las diferentes tecnologías que se van a aplicar. 

 

Figura 25. Ubicación OptoOPCServer 

BROWSER CONFIGURATOR.  Encargado de realizar la configuración de los puntos que 

se pondrán en el servidos OPC. 

OPC TEST CLIENT.  Dedicado para encontrar las configuraciones OPC SERVER que se 

han realizado en la red. 

OPTO OPC SERVER. Con este software realizo la adquisición de las señales de los 

equipos enlazados en la tecnología OPC SERVER. 

 

Figura 26. Snap PAC Learning Center   
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2. DESARROLLO DEL PROYECTO Y PRÁCTICA DE LABORATORIO 
 

Para la aplicación práctica del proyecto se hizo necesaria la configuración de uno de los 

servidores disponibles de OPTO o LabVIEW. Para seleccionar dicho servidor, se 

realizaron pruebas con cada fabricante.  

Las primeras pruebas se realizaron con NI OPC Server de National Instruments, tal 

como se explicó anteriormente en las formas de conectar LabVIEW a un PLC, debido a 

que se tiene una gran variedad de drivers de reconocidas marcas de la Industria, existe 

mayor facilidad de información y ejemplos explicativos donde muestra paso a paso 

como realizar la comunicación incluyendo las herramientas de manipulación de 

variables e históricos, entre otras. 

El problema con NI OPC Server nace al revisar las listas de los fabricantes [11] con los 

cuales se puede entablar la comunicación OPC, en donde no aparece OPTO22. 

Realizando la investigación y consultas con Docentes, representantes de National 

Instruments en Colombia y algunos de Latinoamérica nos damos cuenta de que no se 

tienen datos que alguien haya hecho esta comunicación, puesto que no se había 

generado la necesidad y no ven considerable que se deban comunicar dos fabricantes 

que tengan la misma funcionalidad como SCADA. 

Retomando nuestros objetivos, sabemos que éste proyecto es una aplicación hecha 

actualmente para la academia que permitirá relacionar por medio de una 

comunicación Industrial como el OPC,  los dos sistemas SCADA’s que posee 

actualmente la UPB y sus diferentes equipos de hardware. 

La pregunta que nos hacemos es ¿Cómo se comunican con LabVIEW Los fabricantes y 

dispositivos que no estén en la lista de NI OPC Server y que sean de la OPC Foundation? 

Basando la configuración del Servidor OPC como un estándar ya establecido por la OPC 

Fundation, se asume que las características de los servidores de los diferentes 

fabricantes deben ser iguales en su forma más no necesariamente en su contenido, 

por tanto la solución no está en usar el NI OPC SERVER, ya que éste actualmente no 

tiene los drivers de comunicación con OPTO 22, la solución está en usar el Servidor 

OptoOPCServer. 

Es decir implementamos a Opto22 como Servidor y usamos LabVIEW como Cliente 

OPC a través de los módulos DCS. 
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Figura 27. Diagrama de Implementación del proyecto. [13] 

El desarrollo de la práctica, consta de varios pasos: 

1. Configuración del Servidor OPC en Windows. 

2. Configuración IP del SNAP PAC. 

3. Configuración del Cerebro Controlador y Puntos de proceso. 

4. Cargar variables al Opto OPC Server 

5. Creación del proyecto en LabVIEW 

6. Programación y Aplicación.  

 

2.1  PASOS PARA CONFIGURAR EL SERVIDOR OPC EN WINDOWS 

Usted debe verificar la configuración de DCOM de un servidor OPC local antes de 

conectar un cliente OPC, I/O Server con el servidor OPC. Se Recomienda que configure 

el servidor OPC para funcionar como una identidad del usuario interactivo. 

Siga los pasos siguientes para cambiar y verificar la identidad de la configuración para 

el servidor OPC. 

Inicie sesión en Windows como administrador. 
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En el Panel de control, de Windows, vaya a la carpeta Herramientas Administrativas. 

Haga Doble clic en servicios de componentes de acceso directo para poner en marcha 

los servicios de utilidad de componentes.  

También puede iniciar los servicios de utilidad de componentes seleccionando 

Inicio>>Run, entrando a  dcomcnfg en el símbolo del sistema, y haciendo clic en el 

botón Aceptar. 

 

 

Figura 28. Ejecutar dcomcnfg [13] 

En la ventana Servicios de componentes, seleccione Servicios de componentes 

»Equipos» Mi PC »Configuración de DCOM del árbol de Raíz de la consola para 

mostrar la configuración de DCOM en el equipo. 

 

Figura 29. Configuración DCOM [13] 

Haga clic en el servidor OPC ya instalado en el equipo y seleccione Propiedades desde 

el menú contextual para mostrar el cuadro de diálogo Propiedades.  Si usted no puede 
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encontrar el servidor OPC en la lista de configuración de DCOM comuníquese con 

servicio al cliente del proveedor. 

 En la página de identidad, seleccione el botón de El usuario interactivo. 

 

Figura 30. Usuario Interactivo [13] 

 

Haga clic en el botón Aceptar para cerrar el cuadro de diálogo Propiedades. 

Usted debe reiniciar o redistribuir el servidor OPC para que el cambio surta efecto. 

 

2.2  CONFIGURACIÓN IP del SNAP PAC 

 Configuración dirección IP en controlador PAC  R1. 

 

a. Lo primero que se hace es tener un cable cruzado tipo UTP . 

b. Luego se adjudica una direccion IP fija al computador que se esta utilizando 

con el fin de generar una pequeña red entre el computador y el  Learning 

Center. 

c. Luego vamos a INICIO, TODOS LOS PROGRAMAS, OPTO 22, PAC MANAGER. 

d. Nos sale una ventana y alli vamos a la barra de menus en TOOLS y buscamos 

la opcion de Assing IP Address.   

e. Por consiguiente nos sale una pantalla de estas caracteristicas en la cual 

veremos al lado derecho un boton “Add” como se muestra en la figura b. 
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b

 

Figura 31. Asignación de dirección IP[13] 

f. Al pulsar uno de estos dos botones nos sale la siguiente ventana: 

Acá nosotros damos el dato de dirección MAC que trae el controlador SNAP 

PAC R1.  Hay que tener en cuenta que como este equipo tiene doble puerto de 

red hay que tener cuidado cual es el puerto que vamos a configurar y cual el 

que vamos a conectar por lo tanto hay que ser muy cuidadosos con esto para 

no cometer errores.   Por ahora solo tomamos el dato de Ethernet 1 que es con 

quien comenzaremos las pruebas. 

 

 

Figura 32. Asignando MAC de trabajo [13] 

 Entonces tomamos el dato de la dirección MAC. 

 Luego damos la dirección IP que en este caso tiene que coincidir en los 

tres primero números  de la IP que asignamos fija a nuestro computador 
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y también muy importante la dirección de la mascara de sub red.  Por 

consiguiente nuestra configuración quedara así. 

 

Figura 33. Asignando dirección IP a la MAC [13] 

Esto es un ejemplo por lo tanto hay que respetar muy bien la parte de 

configuraciones de la dirección IP para todos estos casos. 

Luego de asignada la dirección IP, se tendrá una red LAN entre el computador y 

el Learning PAC.   

 

2.3  CONFIGURACIÓN DEL CEREBRO CONTROLADOR Y PUNTOS DEL 

PROCESO.  

Ahora vamos a INICIO>>TODOS LOS PROGRAMAS>>OPTO 22>> PAC CONTROL . 

 

Figura 34. PAC Control Professional [13] 
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Este es el pantallazo de inicio del  programa, ahora esta listo para realizar la 

programación del cerebro controlador y la programación de los I/O de campo que ya 

se tienen conectados al hardware de OPTO 22. 

Para hacer la configuración de los I/O  lo primero que debo hacer es ir a la ventana del 

lado Izquierdo que tengo en el pac Project y buscar la carpeta I/O Units como lo señala 

la flecha. 

 

Figura 35. Carpeta I/O Units [13] 

Al dar doble clic, me aparecerá la siguiente ventana, es aquí donde realizo mi 

configuración, dando clic en el botón “Add”. 

 

Figura 36. Configuración I/O Units [13] 

Luego de dar clic, estará presente esta ventana, la cual me permitirá hacer la 

configuración del cerebro controlador.   Aquí podemos realizar la configuración de la 
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dirección IP, que se va a utilizar para hacer la supervisión y el control del proceso que 

se está desarrollando.  Esta configuración de la dirección IP debe ser corroborada con 

el administrador de red del sitio donde se esté haciendo dicho montaje, debido a que 

puede interferir con la IP de algún equipo que ya esté trabajando. 

 
Figura 37. Dirección IP del SNAP PAC R1 [13] 

Al escoger el tipo de controlador, por estar nosotros con el hardware del LEARNING 

CENTER, ya tenemos escogido el CONTROLADOR  SNAP PAC R1.   

 

 

Figura 38. Selección de tipo de SNAP PAC [13] 
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Luego de haber hecho todas las configuraciones, y oprimir la tecla OK, nos quedara ya 

configurado el equipo de esta forma en esta ventana. 

 

Figura 39. Verificación de configuración del Equipo [13] 

 

Ahora oprimimos el botón I/O Points para configurar las señales que voy a utilizar de 

campo.  Los siguientes cuadros nos muestran los diferentes módulos que tengo para 

hacer conexión de mis señales de entrada y salida de campo. 

 

Figura 40. Agregando los Módulos del SNAP PAC [13] 

Al realizar dicha configuración de las señales de entrada y salida, se observaran las 

siguientes ventanas donde se configuraran lo módulos que se necesitan para dicho 

proceso. 
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SEÑALES DIGITALES DE ENTRADA 

 

Figura 41. Módulos de Entradas Digitales [13] 

 

SEÑALES DIGITALES DE ENTRADA 

 

Figura 42.  Módulos de salidas Digitales [13] 
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SEÑALES ANALOGAS DE ENTRADA 

 

Figura 43. Módulos de Entradas análogas [13] 

 

SEÑALES  ANALOGAS DE SALIDA 

 

Figura 44.  Módulos de Salidas Análogas [13] 
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2.9 Luego de haber realizado las configuraciones necesarias para el montaje de lo que 

tenemos ya hecho en el learning center, nos deben quedar de esta forma, con sus 

respectivas I/Os de salida.  

 

Figura 45. Vista Final configuración de módulos [13] 

 

Esto nos debe quedar en la ventana izquierda en la configuracion de los puntos se 

puede observar de esta manera.  Mostrandonos las señales que se configuraron. 

 

Figura 46. Vista de los Puntos Configurados [13] 
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2.4  PASOS PARA CONFIGURAR EL SERVIDOR OPC EN WINDOWS 

 Vamos a:  INICIO >> TODOS LOS PROGRAMAS  >>  OPTO 22 >>Opto OPCServer  

 

Figura 47. OptoOPCServer [13] 

 

 

Se debe desplegar el Directorio Indirect 

 

Figura 48. Directorio Indirect [13] 

 

En esta ventana, se configura las señales que se van a necesitar para subir al servidor y 

compartir con el software de LabVIEW.  Esto hecho desde el archivo indirect.  
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Figura 49. Configuración de señales para subir al servidor [13] 

 

Las señales o TAGS se seleccionan de esta manera como se muestra en la figura y son 

arrastrados a la ventana blanca de abajo como se muestra en la siguiente figura. 

 

Figura 50. Envío de Tags al servidor. [13] 

Ya teniendo esto listo, y los archivos en la ventana de abajo, se procede  ir a FILE y 

escoger la opción SAVE como se muestra en la figura. 
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Figura 51. Guardando Tags del servidor [13] 

Aparecerá una ventana que nos permitirá, guardar los cambios hechos en 

OptoOPCSERVER.  Oprimimos el botón de Guardar. 

 

Figura 52. Guardando cambios del OptoOPCServer [13] 

 Éste muestra una ventana donde se ve la ubicación exacta del archivo, y la descripción 

de este mismo.  Luego se oprime OK. 
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Figura 53. Ubicación del Archivo de los Tags. [13] 

 

Ahora en este proceso, se actualiza el servido por medio del botón que muestra el 

cursor abre la ventana, se oprime el botón de actualizar. 

 

Figura 54. Actualizando Servidor [13] 

 

 

Figura 55. Localización del Servidor. [13] 

En estos momentos ya quedo actualizado el servidor, por lo tanto, queda todo en la 

red del servidor OPC, por lo tanto el programador de LabVIEW  ya puede entrar a 

tomar las señales y realizar sus respectivas configuraciones. 
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Figura 56. Verificación de subida de base de datos al servidor. [13] 

 

 

2.5  CREACIÓN DEL PROYECTO EN LABVIEW 

Teniendo ya  las variables en el servidor  OptoOPCServer, podemos generar el 

proyecto que llevará todos los archivos que permitirán trabajar la comunicación. 

1. Ingresamos a LabVIEW y creamos un nuevo Proyecto. 

 

Figura 57. Creando un Proyecto en LabVIEW [13] 

 

2. En My Computer de clíck derecho y selecciones New>>I/O Server  y seleccione 

OPC Client. 
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Figura 58. Selección de Cliente OPC [13] 

3. Seleccionamos el servidor con el que vamos a trabajar, en éste caso: 

Opto22.OpcServer.2 En Update Rate (ms) seleccionamos la frecuencia de 

actualización a 100ms.  

 

Figura 59. Selección del Servidor Opto22OPCServer [13] 

 

4. Ahora generamos una librería que contendrá las variables compartidas con el 

servidor. 
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Figura 60. Creación de Librería [13] 

 

5. En ésta nueva librería creamos las variables que manejarán la información del 

servidor  

 

Figura 61. Creación de Variables que manejará LabVIEW [13] 
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6. Buscamos en el OPC creado (el servidor), la carpeta que contiene las variables 

subidas anteriormente desde Opto OPC Server. 

 

Figura 62. Ubicación de las Variables en el Servidor [13] 

7. Seleccionamos una a una las variables con las que vamos a adicionar a la 

librería que finalmente son las que vamos a usar en el proyecto. 

 

Figura 63.  Selección de Tags del Servidor [13] 

 

8. Ahora sobre la librería que contiene las variables creadas, seleccionar Deploy 

(implementar).Y  verificamos que la implementación sea exitosa. 
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Figura 64. Cargar los Tags en el proyecto de LabVIEW [13] 

9. Guardamos el Proyecto y ambas librerías, es conveniente dejar estos tres 

archivos en la misma dirección del PC. 

10. Ahora creamos el nuevo  VI para involucrar las variables y generar la 

programación deseada con ellas. 

 

Figura 65. Creando Nuevo VI en Project explorer. [13] 
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11. Ahora sencillamente seleccionamos las variables a usar desde el Project 

Explorer y las arrastramos al panel frontal de LabVIEW.  

 

Figura 66. Inserción de las Variables compartidas al VI. [13] 

12. Enhorabuena, Ahora podemos hacer la programación que se desee 

involucrando las variables que hemos subido al servidor y que adicionamos al 

proyecto, aprovechando el potencial de programación de LabVIEW y la 

practicidad y flexibilidad del SNAP PAC Learning Center de Opto22. 

 

Figura 67. HMI de supervisión del SNAP PAC. [13] 
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3. RECOMENDACIONES 
 

3.1  Generales 

 Se debe tener conocimientos en sistemas SCADA y en Herramientas 

computacionales, fundamentos en LabVIEW y Opto22. 

 Se debe tener las protecciones necesarias respecto a la parte eléctrica, 

sobrevoltaje y caídas de voltaje, evitar desenergizar el equipo mientras el software 

esté tomando datos de proceso. 

 Verificar los cables de red tanto en la configuración (cable cruzado), como 

también equipos (routers, switches, acces points) y proceso. 

 Si se va a implementar la comunicación OPC en un proceso en particular que exija 

mayor capacidad del PC y de instrumentación y tiene dificultades en cuanto a 

trabajo y desempeño se recomienda comunicarse con el servicio al cliente de 

National Instruments en Colombia y/o Sincrón. 

 

3.2 Respecto al PC 

 Es recomendable que el computador a usar tenga como sistema operativo 

Windows XP, Vista o Windows 7, el procesador puede ser mínimo de Intel Pentium 

IV, o un AMD Athlon 64 o de mayor capacidad, un disco duro que tenga capacidad 

suficiente de acuerdo a los requerimientos como históricos, alarmas, etc. 

 Un adaptador de red con el chipset de Ethernet. El adaptador puede estar 

integrado al motherboard o a un puerto PCI, por ejemplo dispositivos 10/100 

:Intel® 8255x Family, Dispositivos Gigabit, entre otras. Cabe anotar que los 

computadores que se tienen actualmente dentro de la universidad y los que se 

siguen adquiriendo, cumplen con los requisitos técnicos para operar éste proyecto. 

si tiene alguna dificultad puede comunicarse con el servicio al cliente de National 

Instruments en Colombia. 

3.3 Software 

 Es importante contar con la instalación del software LabVIEW y  los módulos DCS y 

NI OPC Servers; también vale la pena complementar con el Report Generator 

Toolkit, para tabular y manipular de forma más organizada los datos que se desean 

registrar. 

 Igualmente la instalación del OPTO 22, el PAC Project 8.2 y el OptoOPCServer.    
 

3.4 Respecto al SNAP PAC  

 Tener en cuenta que los módulos están diferenciados, por los colores que tienen 

en la parte superior, para que no hayan equivocaciones de conexión. 
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 La fuente de alimentación que se recomienda para el opto 22 es una fuente de 5 

voltios que se debe pedir de fabrica, y para la parte de instrumentación se 

recomienda otra fuente diferente a la de alimentación del opto, y también que sea 

separada.  No usar fuentes duales para estos tipos de aplicaciones. 

 Cuando se usan las dos IPs se debe tener en cuenta, que alguna este conectada a 

una red interna entre el computador de control y otra que sea para monitoreo en 

otra red, esto por el inconveniente de que cuando hay control se corren muchos 

riesgos si el proceso llegase a tener varias personas manejándolo. 

 Se recomienda revisar muy bien los manuales que opto 22 genera, con el fin de 

resolver alguna duda más profunda.  Estos manuales son gratis y se descargan de la 

página www.opto22.com. 

 Leer todo y estar muy atento a las indicaciones tanto de hardware como de 

software, que me permiten mejorar la estrategia. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.opto22.com/
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4. CONCLUSIONES 
 

Las aplicaciones OPC permiten la implementación de LabVIEW como sistema SCADA 

para la arquitectura de control OPTO22, gracias al concepto estandarizado de 

integración que manejan los protocolos de comunicación.   Esto rompe el paradigma 

de la dificultad en la comunicación entre dos arquitecturas de control de diferentes 

fabricantes. 

En la integración de arquitecturas de control, sin importar con cual fabricante se 

trabaje, siempre y cuando se esté bajo los estándares de la OPC Foundation, las 

características de los servidores deben ser iguales en su forma, más no necesariamente 

en su contenido (las plataformas), así ellos se pueden comunicar con todo aquel 

fabricante que cumpla dicho estándar.  

Con el desarrollo del proyecto se puede concluir que para comunicar a LabVIEW como 

Sistema SCADA con cualquier equipo que funcione con protocolo OPC, lo primero que 

se debe hacer es verificar si en NI OPC Server se encuentra el driver que se necesita del 

equipo, si éste se encuentra, procedemos a utilizar la herramienta de LabVIEW como 

servidor. Si es el caso de no tener el driver como en éste proyecto, se procede a 

implementar el Servidor del Fabricante del equipo y se deja a LabVIEW como cliente. 

Trabajar con OPC permite que cada empresa pueda crear aplicaciones de medición y 

control hechas a su medida, sin tener que depender de una sola casa fabricante de 

equipos y sin tener que pagar los altos costos que implica el licenciamiento de 

software industrial. 

Las comunicaciones industriales son una herramienta fundamental que debe ser 

profundizada por los estudiantes e ingenieros en el transcurso de su aprendizaje en las 

aulas, permitiendo expandir la recursividad e innovación sin limitarse a una sola 

arquitectura de control, evitando los matrimonios con una determinada tecnología.   

Existen en el mercado una gran variedad de soluciones integrales en automatización 

que abarcan los niveles operativos y de gestión de las empresas; no hay opciones 

buenas o malas siempre y cuando se encuentren dentro de los estándares para efectos 

de integración tecnológica, en cuyo caso todo dependerá de las necesidades del 

proceso y del cliente. 

No hay nada tan práctico en el mundo de la automatización como una buena 

conceptualización teórica. 
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